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SI 5 Installation and Administration Guide 
 

The D-Tools System Integrator version 5 (SI5) Installation and Administration Guide was designed 

for Microsoft Visio 2003/2007, AutoCAD Version 2006-2009 and D-Tools SI5 system integration 

software. 

This document and its contents is the copyright of D-Tools, Inc. 2007. All rights reserved. 

Any redistribution or reproduction of part or all of the contents in any form is prohibited other than 

the following: 

 you may print or download to a local hard disk extracts for your personal and non-

commercial use only 

 you may copy the content to individual third parties for their personal use. 

You may not, except with our express written permission, distribute or commercially exploit the 

content. Nor may you transmit it or store it in any other website or other form of electronic 

retrieval system. 

Product and technology names mentioned in this material are the registered trademarks of their 

respected companies. 
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Welcome to D-Tools SI5! 
Welcome to the growing family of D-Tools System Integrator (SI) users!  I want to thank you 

for putting your confidence in D-Tools software.  We know that D-Tools SI5 will be a powerful 

enhancement to your system integration business.  D-Tools SI is the leader in complete system 

integration software and has been proven by thousands of system integration companies that are 

already using it to more effectively design, engineer, document, estimate, sell, install, and manage 

their low voltage projects.  In fact, many companies have seen the software pay for itself in the 

first project through increased efficiencies throughout the company. 

This latest version of D-Tools SI has been extensively tested on various computer platforms, but it 

has not been tested on the most important one… yours.  Give it a try, run through a sample 

project, test it, and by all means, please don’t hesitate to contact us to report any issues or 

questions so we can continue to improve the software.  You will receive free in-version updates to 

our product over time as we continue to hone the product and add even more enhancements.  We 

want you to be successful with this product.  Feel free to contact us with ideas and thoughts about 

the program.  Some of our best enhancements have come from users just like you. 

While D-Tools has been designed to be simple to use, it is also a very deep and full functioned 

software product.  I have included some ideas you can use to make a smoother transition from 

your previous design, estimating and business management procedures to D-Tools SI: 

• Take a moment to peruse the user guide included with the software before jumping right in.  

This guide is full of tips, tricks, and detailed information that will help you get the most from 

the software. 

• Your corporate product database is one of your most important business assets.  Take the 

time to prepare your database by following the steps outlined in the Manage My Product 

Data (MMPD) interface.  MMPD was specifically designed to easily allow you to add, edit and 

enhance your product data.  In addition don’t forget to make frequent backups of your D-

Tools SI database and projects. 

• Open one of the sample projects included in your software.  See how we have created 

packages, accessories and miscellaneous labor costs.  Run all the reports you have available 

with this demo project.  Finally, take a small project that you have completed in the past, 

one that is successful and you are happy with.  This will allow you to get familiar with the 

program and begin to create a custom database of your most used products. 
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D-Tools Contact Information 
Offices 

Western U.S. Office 
1850 Gateway Blvd – Suite 1060 
Concord, CA  94520 
Phone: 925.681.2326 
Fax: 925.681.2900 
Web: www.d-tools.com 
 
Mid-Western U.S. Office 
2001 Crocker Road – Suite 220 
Westlake, OH  44145 
Phone: 925.681.2326 
Fax: 925.681.2900 
 
Eastern U.S. Office 
2839 Paces Ferry Road – Suite 370 
Atlanta, GA  30339 
Phone: 770.444.3101 
Fax: 770.444.3991 

Sales: 
Phone: 866.386.6571, Option 1 
Email: sales@d-tools.com 

Training: 
Phone: 866.386.6571, Option 3 
Email: training@d-tools.com 

Consulting: 
Phone: 866.386.6571, Option 1 
Email: consulting@d-tools.com 

Administration 
Phone: 866.386.6571, Option 0 
Email: info@d-tools.com 

Technical Support 
Phone: 866.386.6571, Option 2 
Online Cases: www.d-tools.com/support/submit-an-issue.html 
Web: www.d-tools.com/site/support/contact.html 
Forum: www.d-tools.us 
WikiBlog: www.support.d-toolsblog.com/ 

Manufacturer Vantage Point (MVP) Program: 
Phone: 866.386.6571, Option 5 
Email: mvp@d-tools.com 
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Software License Agreements 
End-User License Agreement for D-Tools System Integrator 5 

DO NOT INSTALL OR USE THE SOFTWARE UNTIL YOU HAVE READ AND ACCEPTED ALL OF THE 
LICENSE TERMS.  
Permission to use the software is conditional upon your agreement with these license terms (the "License").  Installation or use of the 
software by you will be deemed to be acceptance of the License and will create a legally enforceable contract with D-Tools, Inc.  IF YOU DO 
NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT INSTALL THE ACCOMPANYING SOFTWARE. IF YOU HAVE INSTALLED IT, 
PROMPTLY REMOVE ALL COPIES OF IT FROM YOUR COMPUTER. IF YOU PAID FOR THE RIGHT TO USE IT, RETURN IT IN ITS 
ORIGINAL CONDITION, WITH YOUR RECEIPT, TO THE POINT OF PURCHASE FOR A FULL REFUND. 
The installation of this program will install files necessary to operate the program onto your computer. Other system files, such as DLLs may 
be installed or updated and Windows registry entries will be made. Uninstalling the program will not remove all of the installed files or registry 
entries. As with all installations, it is recommended that you back up your hard drive before you install this program. 
  

Software License and Limited Warranty 

1. GRANT OF LICENSE. D-Tools, Inc., as Licensor, grants to you, the Licensee, a non-exclusive right to use a single copy of this software 
program in object code form (hereinafter the "SOFTWARE") in accordance with the terms contained in this License Agreement. You may 
not: 
a. Use the SOFTWARE on more than one computer or workstation at a time, or use it on a device functioning as a file server in a 

network or a multi-user system, or in any manner make it accessible to others, including via an electronic bulletin board, web site or 
other form of electronic distribution system;  

b. Modify, translate, reverse engineer, decompile, disassemble, create derivative works based on, or copy the SOFTWARE or the 
accompanying documentation, except to the extent, if any, that this limitation or any portion of it is expressly prohibited by 
applicable law and provided that you may make a single copy of the SOFTWARE for backup purposes only;  

c. Rent, lease or sublicense any rights in the SOFTWARE or accompanying documentation in any form to any person without the prior 
written consent of D-Tools, Inc., which, if given, is subject to the transferee's consent to the terms and conditions of this License;  

d. Remove any proprietary notices, labels, or marks on the SOFTWARE, documentation, and containers. 
 
2. OWNERSHIP OF SOFTWARE. D-Tools, Inc. retains the copyright, title and ownership of the SOFTWARE and the written materials 

regardless of the form or media in or on which the original and other copies may exist. 
 
3. TRANSFERS. You may transfer the SOFTWARE from one of your computers to another computer or person provided that the SOFTWARE 

is transferred without modification and, if the SOFTWARE is transferred to another person, that person agrees to be bound by the terms 
of this License, you obtain the written consent of D-Tools, Inc. prior to transferring the SOFTWARE, and you deliver to that person all 
existing copies of the SOFTWARE (or destroy any copies that are not delivered to that person), including the original and any installed or 
backup copies.  

 
4. TERM. The license granted under this License commences upon the installation of the SOFTWARE after acceptance of the terms of this 

License and is effective until terminated as provided herein. You may terminate this License at any time by destroying all copies of the 
SOFTWARE or by returning them to D-Tools, Inc.  D-Tools, Inc. may terminate this License if you fail to comply with any of the terms 
and conditions of this License Agreement.  Upon such termination, you agree to destroy or return the original and all copies of the 
SOFTWARE. 

 
5. US GOVERNMENT RIGHTS. The SOFTWARE is commercial computer software developed exclusively at private expense, and in all 

respects is proprietary data belonging to D-Tools, Inc. or its suppliers.  (a) Department of Defense End Users. If the SOFTWARE is 
acquired by or on behalf of agencies or units of the Department of Defense (DoD), then, pursuant to DoD FAR Supplement Section 
227.7202 and its successors (48 C.F.R. 227.7202) the Government's right to use, reproduce or disclose the SOFTWARE is subject to the 
restrictions of this Agreement.  (b) Civilian Agency End Users. If the SOFTWARE is acquired by or on behalf of Civilian agencies of the 
U.S. Government, then, pursuant to FAR Section 12.212 and its successors (47 C.F.R. 12.212), the Government's right to use, reproduce 
or disclose the SOFTWARE is subject to the restrictions of this Agreement. 

 
6. LIMITED WARRANTY.  D-Tools, Inc. warrants the media on which the SOFTWARE is furnished to be free of defects in material and 

workmanship, under normal use, for a period of ninety (90) days following the date of delivery to you. In the event of defects, D-Tools 
Inc.' sole liability shall be to replace the defective media which has been returned to D-Tools, Inc. or the supplier with your dated 
invoice, and is shown to be defective. In the event that D-Tools, Inc. is unable to replace defective media, D-Tools, Inc. shall refund your 
money upon your termination of this License.  THE ABOVE IS THE ONLY WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, 
THAT IS MADE BY D-TOOLS, INC., ON THIS D-TOOLS, INC. PRODUCT.  NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY 
D-TOOLS, INC., ITS DEALERS, DISTRIBUTORS, AGENTS OR EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE 
SCOPE OF THIS WARRANTY AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. YOU MAY HAVE OTHER RIGHTS, 
WHICH VARY FROM STATE TO STATE. 
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7. THE SOFTWARE AND ACCOMPANYING DOCUMENTATION (INCLUDING INSTRUCTIONS FOR USE) ARE PROVIDED "AS IS" WITHOUT 
WARRANTY OF ANY KIND EXCEPT FOR THE EXPRESS MEDIA WARRANTY IN SECTION 6 ABOVE.  FURTHER, D-TOOLS, INC. DOES NOT 
WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF USE, OF THE SOFTWARE OR 
DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. YOU ASSUME THE ENTIRE 
RISK AS TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE. IF THE SOFTWARE OR WRITTEN MATERIALS ARE DEFECTIVE 
YOU, AND NOT D-TOOLS, INC. OR ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES, ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVISCNG, REPAIR OR CORRECTION.  YOU ACKNOWLEDGE THAT THE SOFTWARE IS INTENDED TO BE USED SOLELY 
FOR COMMERSCAL BUSINESS PURPOSES AND IS NOT A CONSUMER PRODUCT. 

 
8. NEITHER D-TOOLS, INC. NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION OR DELIVERY OF THIS 

PRODUCT SHALL BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL OR INSCDENTAL DAMAGES (INCLUDING DAMAGES FOR 
LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE 
USE OR INABILITY TO USE SUCH PRODUCT EVEN IF D-TOOLS, INC. HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

 
9. Should any other warranties be found to exist, such warranties shall be limited in duration to ninety (90) days following the date of 

delivery to you. In no event will D-Tools, Inc.' liability for any damages to you or any other person exceed the amount paid for the 
license to use the SOFTWARE. 

 
10. This License shall be governed and construed in accordance with the laws of the State of California and shall be binding on and inure to 

the benefit of D-Tools, Inc., its successors and assigns.  
 

Database License Agreement 

Use of the data in the D-Tools, Inc.  database is subject to the following terms and conditions: 
 
Rights in Data: D-Tools, Inc. is providing limited access to the data contained in this database (the "Data") under the licensed described 
below.  Except for the limited use rights granted through this license, all right, title and interest in the Data are and will continue to be the 
exclusive property of D-Tools, Inc. and its licensors. 
 
Registered Customers Only:  In order to use the Data, you must be an authorized licensee of a D-Tools, Inc. application and must have 
registered as a D-Tools, Inc. customer with the appropriate passwords for the "members only" section of the D-Tools, Inc. www site.  Such 
authorized customers are referred to as "Licensees." 
Limited License:  D-Tools, Inc. hereby grants Licensee a non-exclusive, non-transferable, limited license to access the Data solely for use with 
the D-Tools, Inc. applications and for no other purpose.  This license includes the right to download, install and store the Data ("Downloaded 
Data") using the D-Tools, Inc.  installer application provided for this purpose to a storage device under Licensee's exclusive control solely (i) to 
display internally such Downloaded Data and (ii) to quote and excerpt from such Downloaded Data by electronic cutting and pasting or other 
means in work product created by Licensee in the regular course of its work using the D-Tools, Inc. application. Licensee may also create 
printouts of Data for internal use and for distribution to third parties only for purposes of planning and implementing individual projects using 
the Data in connection with the planning, bidding, purchasing, constructing and billing processes. 
 
Limitations:  No person or entity who does not qualify as a Licensee under the above definition may access the Data or use the Data for any 
purpose.  With respect to Licensees: Except as expressly provided in this License Agreement, Licensee may not copy, download, store, 
publish, transmit, transfer, sell or otherwise use the Data, or any portion of the Data, in any form or by any means. Downloaded Data shall 
not be stored or used in an archival database or other searchable database except as part of the D-Tools, Inc.  application. Licensee shall not 
sell, license or distribute Data (including printouts and Downloaded Data) to third parties or use Data as a component of or as a basis for any 
material offered for sale, license or distribution. 

Notice to SI4 and SI3 upgrade users  

If you are upgrading from a previous version of System Integrator, the licenses for your previous versions will expire 180 days after you install 
SI5 and will not be available after that date. Contact D-Tools support for more information. 

End-User License Agreement for Microsoft Office Visio® 2007 

These license terms are an agreement between the licensor of the software application or suite of applications with which you acquired the 
Microsoft software (“Licensor”) and you.  Please read them.  They apply to the software that accompanies these license terms, which includes 
the media on which you received it, if any.  The terms also apply to any Microsoft updates, supplements, and Internet-based services for this 
software, unless other terms accompany those items.  If so, those terms apply. Microsoft Corporation or one of its affiliates (collectively, 
“Microsoft”) has licensed the software to Licensor. 

BY USING THE SOFTWARE, YOU ACCEPT THESE TERMS.  IF YOU DO NOT ACCEPT THEM, DO NOT USE THE SOFTWARE.  
INSTEAD, RETURN IT TO THE PLACE OF PURCHASE FOR A REFUND OR CREDIT.   

AS DESCRIBED BELOW, USING THE SOFTWARE ALSO OPERATES AS YOUR CONSENT TO THE TRANSMISSION OF CERTAIN 
COMPUTER INFORMATION DURING ACTIVATION, VALIDATION AND FOR INTERNET-BASED SERVICES. 

These terms supersede any electronic terms which may be contained within the software. If any of the terms contained within the software 
conflict with these terms, these terms will control.  

IF YOU COMPLY WITH THESE LICENSE TERMS, YOU HAVE THE RIGHTS BELOW FOR EACH LICENSE YOU ACQUIRE. 
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OVERVIEW.  These license terms permit installation and use of one copy of the software on one device, along with other rights, all as 
described below. 

INSTALLATION AND USE RIGHTS.  Before you use the software under a license, you must assign that license to one device.  That device 
is the “licensed device.”  A hardware partition or blade is considered to be a separate device.   

Licensed Device.  You may install and use one copy of the software on the licensed device. 

Portable Device.  You may install another copy on a portable device for use by the single primary user of the licensed 
device. 

Separation of Components.  The components of the software are licensed as a single unit.  You may not separate the 
components and install them on different devices. 

ADDITIONAL LICENSING REQUIREMENTS AND/OR USE RIGHTS. 

Remote Access. The single primary user of the licensed device may access and use the software installed on the licensed device 
remotely from any other device.  You may allow other users to access the software to provide you with support services.  You do 
not need additional licenses for this access. No other person may use the software under the same license at the same time for any 
other purpose. 

Media Elements and Templates.  You may copy and use images, clip art, animations, sounds, music, shapes, video clips 
and templates provided with the software and identified for such use in documents and projects that you create.  You may 
distribute those documents and projects non-commercially.  If you wish to use these media elements or templates for any other 
purpose, go to www.microsoft.com/permission to learn whether that use is allowed. 

Font Components. While the software is running, you may use its fonts to display and print content. You may only embed 
fonts in content as permitted by the embedding restrictions in the fonts; and temporarily download them to a printer or other 
output device to help print content. 

Multiplexing.  Hardware or software you use to pool connections, or reduce the number of devices or users that directly 
access or use the software (sometimes referred to as “multiplexing” or “pooling”), does not reduce the number of licenses you 
need. 

Trial and Conversion.  Some or all of the software may be licensed on a trial basis.  Your rights to use trial software are limited to the 
trial period.  The trial software and length of the trial period are set forth during the activation process.  You may have the option to 
convert your trial rights to subscription or perpetual rights.  Conversion options will be presented to you at the expiration of your 
trial period.  After the expiration of any trial period without conversion, most features of the trial software will stop running.  At that 
time you can continue to open, view and print any documents you created with the trial software. 

Subscription Software.  If you licensed the software on a subscription basis, your rights to use the software are limited to the 
subscription period.  You may have the option to extend your subscription or convert to a perpetual license.  If you extend your 
subscription, you may continue using the software until the end of your extended subscription period.  See the software activation 
screens or other accompanying materials for subscription details.  After the expiration of your subscription, most features of the 
software will stop running.  At that time you can continue to open, view and print any documents you created with the software. 

Pre-Activation. If you acquired an edition other than Microsoft Office Ultimate 2007, some functionality is licensed for your use only 
until you activate the software or the end of the time recommended for activation, whichever comes first.   

Home Use Rights Edition.  If you licensed a Home Use Rights edition, the licensed device must be used primarily within your home. 

Development Tools.  The software may contain Microsoft Visual Studio Tools for Applications or other development tools.  You may 
use any development tools included in the software only to design, develop, test, use and demonstrate your programs with the 
software. 

MANDATORY ACTIVATION.  Activation associates the use of the software with a specific device. During activation, the software will send 
information about the software and the device to Microsoft. This information includes the version, the license version, language and the 
product ID of the software, Internet protocol address of the device and information derived from the hardware configuration.  For more 
information, see www.microsoft.com/piracy/activation.mspx.   BY USING THE SOFTWARE, YOU CONSENT TO THE TRANSMISSION OF 
THIS INFORMATION.  After the time recommended for activation expires, your rights to use the software will be limited until the 
software is activated.  This is to prevent its unlicensed use.  You can activate the software by Internet or telephone; Internet and 
telephone service charges may apply.  Some changes to your computer components or the software may require you to reactivate the 
software.  THE SOFTWARE WILL REMIND YOU TO ACTIVATE UNTIL YOU DO. 

VALIDATION. 

The software will from time to time update or require download of the validation feature of the software.  Validation verifies that the 
software has been activated and is properly licensed.  Validation also permits you to use certain features of the software or to 
obtain additional benefits. For more information, see www.microsoft.com/genuine/office/WhyValidate.aspx. 

During a validation check, the software will send information about the software to Microsoft. This information includes the version of the 
software and the product key.  Microsoft does not use the information to identify or contact you.  BY USING THE SOFTWARE, YOU 
CONSENT TO THE TRANSMISSION OF THIS INFORMATION.  For more information, see 
www.microsoft.com/genuine/office/PrivacyInfo.aspx. 

If the software is not properly licensed, the functionality of the software may be affected.  For example, you may need to reactivate the 
software, or receive reminders to obtain a properly licensed copy of the software, or not obtain certain updates, upgrades or 
services from Microsoft. 
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You may only obtain updates or upgrades for the software from Microsoft or authorized sources.  For more information on obtaining 
updates from authorized sources, see www.microsoft.com/genuine/downloads/faq.aspx. 

INTERNET-BASED SERVICES.  Microsoft provides Internet-based services with the software.  Except as otherwise noted in materials 
accompanying a service, it may change or cancel them at any time. 

Consent for Internet-Based Services.  The software features described below connect to Microsoft or service provider computer 
systems over the Internet.  In some cases, you will not receive a separate notice when they connect.  Unless otherwise noted, you 
may switch off these features or not use them.  For more information about these features, see www.office.microsoft.com/en-
us/FX010986541033.aspx.  BY USING THESE FEATURES, YOU CONSENT TO THE TRANSMISSION OF THIS INFORMATION.  
Microsoft does not use the information to identify or contact you. 

Computer Information.  The following features use Internet protocols, which send to the appropriate systems computer information, 
such as your Internet protocol address, the type of operating system, browser and name and version of the software you are using, 
and the language code of the device where you installed the software.  Microsoft uses this information to make the Internet-based 
services available to you. 

Web Content Features.  Features in the software can retrieve related content from Microsoft and provide it to you.  Examples of 
these features are clip art, templates, online training, online assistance and Appshelp.  You may choose not to use these web 
content features. 

Digital Certificates.  The software uses digital certificates.  These digital certificates confirm the identity of Internet users sending 
X.509 standard encrypted information.  They also can be used to digitally sign files and macros to verify the integrity and origin of 
the file contents.  The software retrieves certificates and updates certificate revocation lists using the Internet, when available. 

Information Rights Management.  The software contains a feature that allows you to create content that cannot be printed, copied 
or sent to others without your permission. You may need to connect to Microsoft to use this feature for the first time. Once a year, 
you may need to re-connect to Microsoft to update it. For more information, go to www.office.microsoft.com/en-
us/assistance/HA010397891033.aspx.  You may choose not to use this feature. 

Misuse of Internet-based Services.  You may not use these services in any way that could harm them or impair anyone else’s use of 
them.  You may not use the services to try to gain unauthorized access to any service, data, account or network by any means. 

SCOPE OF LICENSE.  The software is licensed, not sold. This agreement only gives you some rights to use the software.  Licensor and 
Microsoft reserve all other rights.  Unless applicable law gives you more rights despite this limitation, you may use the software only as 
expressly permitted in this agreement.  In doing so, you must comply with any technical limitations in the software that only allow you to 
use it in certain ways.  For more information, see www.microsoft.com/licensing/userights.  You may not: 

work around any technical limitations in the software; 

reverse engineer, decompile or disassemble the software, except and only to the extent that applicable law expressly permits, despite 
this limitation; 

make more copies of the software than specified in this agreement or allowed by applicable law, despite this limitation; 

publish the software for others to copy; 

use the software in any way that is against the law; 

rent, lease or lend the software; or 

use the software for commercial software hosting services. 

BACKUP COPY.  You may make one backup copy of the media.  You may use it only to reinstall the software. 

DOCUMENTATION.  Any person that has valid access to your computer or internal network may copy and use the documentation for your 
internal, reference purposes. 

NOT FOR RESALE SOFTWARE.  You may not sell software marked as “NFR” or “Not for Resale.” 

ACADEMIC EDITION SOFTWARE.  You must be a “Qualified Educational User” to use software marked as “Academic Edition” or “AE.”   If 
you do not know whether you are a Qualified Educational User, visit www.microsoft.com/education or contact the Microsoft affiliate 
serving your country. 

HOME USE RIGHTS SOFTWARE.  You must be a “Home Use Rights User” to use software marked as “Home Use Rights Edition.”  To be a 
Home Use Rights User, you must be both: 

an employee of an organization that has a Microsoft Volume License agreement with Software Assurance, and 

the user of a licensed copy of the software, or a product that includes the software, with active Software Assurance.   

UPGRADE OR CONVERSION.  To upgrade or convert software, you must first be licensed for the software that is eligible for the upgrade or 
conversion.  Upon upgrade or conversion, this agreement takes the place of the agreement for the software you upgraded or converted 
from.  After you upgrade or convert, you may no longer use the earlier version of the software you upgraded or converted from. 

REASSIGN TO ANOTHER DEVICE.  You may reassign the license to a different device any number of times, but not more than one time 
every 90 days.  If you reassign, that other device becomes the “licensed device.”  If you retire the licensed device due to hardware 
failure, you may reassign the license sooner. 
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TRANSFER TO A THIRD PARTY.  The first user of the software may make a one-time transfer of the software, and this agreement, directly 
to another end user as part of a transfer of the integrated software turnkey application or suite of applications (the “Unified Solution”) 
delivered to you by or on behalf of the Licensor solely as part of the Unified Solution.  The first user must uninstall the software before 
transferring it separately from the device.  The first user may not retain any copies. Before any permitted transfer, the end user must 
agree that this agreement applies to the transfer and use of the software. 

EXPORT RESTRICTIONS.  The software is subject to United States export laws and regulations.  You must comply with all domestic and 
international export laws and regulations that apply to the software.  These laws include restrictions on destinations, end users and end 
use.  For additional information, see www.microsoft.com/exporting. 

ENTIRE AGREEMENT.  This agreement, any addendum or amendment included with the software, and the terms for supplements, updates 
and Internet-based services that you use, are the entire agreement for the software. 

LEGAL EFFECT.  This agreement describes certain legal rights.  You may have other rights under the laws of your state or country.  You may 
also have rights with respect to the Licensor from whom you acquired the software.  This agreement does not change your rights under 
the laws of your state or country if the laws of your state or country do not permit it to do so. 

NOT FAULT TOLERANT.  THE SOFTWARE IS NOT FAULT TOLERANT.  LICENSOR HAS INDEPENDENTLY DETERMINED HOW TO 
USE THE SOFTWARE IN THE INTEGRATED SOFTWARE APPLICATION OR SUITE OF APPLICATIONS THAT IT IS 
LICENSING TO YOU, AND MICROSOFT HAS RELIED ON LICENSOR TO CONDUCT SUFFICIENT TESTING TO DETERMINE 
THAT THE SOFTWARE IS SUITABLE FOR SUCH USE. 

NO WARRANTIES BY MICROSOFT.  YOU AGREE THAT IF YOU HAVE RECEIVED ANY WARRANTIES WITH REGARD TO EITHER 
(A) THE SOFTWARE, OR (B) THE SOFTWARE APPLICATION OR SUITE OF APPLICATIONS WITH WHICH YOU ACQUIRED 
THE SOFTWARE, THEN THOSE WARRANTIES ARE PROVIDED SOLELY BY THE LICENSOR AND DO NOT ORIGINATE FROM, 
AND ARE NOT BINDING ON, MICROSOFT. 

NO LIABILITY OF MICROSOFT FOR CERTAIN DAMAGES.  TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, 
MICROSOFT SHALL HAVE NO LIABILITY FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL OR INCIDENTAL DAMAGES 
ARISING FROM OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THE SOFTWARE OR THE SOFTWARE 
APPLICATION OR SUITE OF APPLICATIONS WITH WHICH YOU ACQUIRED THE SOFTWARE, INCLUDING WITHOUT 
LIMITATION, PENALTIES IMPOSED BY GOVERNMENT.  THIS LIMITATION WILL APPLY EVEN IF ANY REMEDY FAILS OF 
ITS ESSENTIAL PURPOSE.  IN NO EVENT SHALL MICROSOFT BE LIABLE FOR ANY AMOUNT IN EXCESS OF TWO HUNDRED 
FIFTY U.S. DOLLARS (US$250.00). 

Microsoft is a registered trademark of Microsoft Corporation in the United States and/or other countries. 
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About This Guide 
This guide is undergoing constant revision.  You may find that some sections are not consistent 

with the screens or functionality you see.  Feel free to contact us over any discrepancies and we 

will update these sections as quickly as possible.  You may download the most recent versions via 

the following links: 

Installation and Administration Guide 

http://downloads.d-
tools.com/si5/documents/training/SI_5_Installation_and_Administration_Guide.pdf 

User Guide 

http://downloads.d-tools.com/si5/documents/training/SI_5_User_Guide.pdf 

Help Videos 

http://downloads.d-tools.com/si5/documents/SI5_Help_Videos.html 

Tutorial 
http://downloads.d-tools.com/si5/documents/training/SI_5_Tutorial.pdf 

This document along with the SI 5 Tutorial and the User Guide will help maximize the return on 

your D-Tools investment.  SI 5 is a very feature rich product.  If you have specific questions, scan 

the Table of Contents or look for keywords in the index.  If you find we have left out something, 

please let us know.  We are releasing this document in PDF format so that it may be more easily 

updated as SI 5 continues to evolve.  Please give us you feedback.  We want to know how we can 

further improve both our products and our documentation.   

Thanks, 

The SI5 Documentation Team
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System Requirements 
Hardware requirements 

2 GHz Pentium 4 (Dual Core Processors recommended)  

1 GB RAM (2 GB is recommended)  

CD drive (DVD drive is recommend for future compatibility) 

XGA (1024x768) or better display device (Dual Displays recommended) 

OS Requirements 
Microsoft Windows XP with SP2 or later 

Microsoft Windows Vista 

Microsoft Windows 7 

Microsoft Server 2003 

Microsoft Server 2005 

Will work with both 32-bit and 64-bit operating systems running on a PC. 

Windows Required Components 
Windows Installer 3.1 (this likely already on your machine but if not Click here to download) 

.Net Framework 3.5 SP1  (Included on CD, will be installed during SI 5 install) 

SQL Server Compact 3.5 SP1  (Included on CD, will be installed during SI 5 install) 

Compatibility 
SI 5 is compatible with the following third party applications: 

Microsoft Visio 2003 & 2007* 

Microsoft Office 2007 

Microsoft Project 2003 & 2007 

AutoCAD**  2006-2010 



System Requirements  20

QuickBooks Pro/Premier  

(US 2006-2010, CAN 2006-2008, UK 2005, 2008) 

QuickBooks Enterprise (US 7-9) 

*Visio Standard 2007 included on disk 

** Only 32-bit versions of AutoCAD.  To work with AutoCAD, your Operating System must be 32-

bit as well, AutoCAD does not run in WOW mode on 64-bit machines.  Must be Full version of 

AutoCAD.  

 

If applicable, please install the third party drawing software you plan to use prior to installing SI 5.  

A license to Visio 2007 Standard is included on your install disc.  You will find the installer located 

inside the Visio2007 folder on the SI 5 CD, or CD image
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Installing the SI5.5 Server 
 

1) Insert disc into CD or DVD drive.   

2) If the installation process does not automatically begin, browse to the CD drive and Double-

click the Install.hta file.  The D-Tools System Integrator 5.5 install from will open.  Choose 

Install System Integrator 5.5 Server. 
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3) The installer will determine if all prerequisites are installed.  Click [Next >]. 

 

4) Click [Next >] to install any missing prerequisites.  Follow the onscreen instructions for the 

third-party installs. 



 SI5 User and Administration Guide 23

 

You may be required to restart your PC after the prerequisites install 

 

5) When your PC restarts, the installation for SI 5 will continue automatically.  Click [Next >] to 

proceed. 
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6) The “Read me” file will display. Read through this and then click [Next >] 

 

7) We recommend leaving the default install folder but you may choose a specific directory if you 

desire.  Click [Next >] to proceed. 
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8) Click [Next >] on the Configure Shortcuts step: 
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9) Read and Accept the End-User License Agreement and then click [Next >] 

 

10)  Confirm you decision to install by clicking [Install] 
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11)  The install will complete.  You must now configure your server (steps follow).  Click [Finish] 

 

12)  Choose your “Run As” option.  We recommend leaving this set to “Current user”.  DO NOT 

click [Cancel]. 
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13)  Immediately following this selection, the SI5 Server Configuration Wizard will open.  Click 

[Next >].  If you cancel this configuration at any time before completing, you can run the 

Server Configuration Wizard manually via this file C:\Program Files\D-Tools\SI 

5\Server\ServerConfigurationWizard.exe: 

 

14)   This step checks whether you are upgrading from previous version of SI, click [Next >] 
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15)   Click [Next] once you read this form 

 

16)   This next step will display with all of your information.  Request Port “9000” is the default.   If 

you change this, make sure that the port you choose is allowed through your firewall if you are 
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using one.  You can also change the default paths for the Project File and Product Share folders.  

We recommend you leave these to the defaults. 

 

 

17) Create an Administrator password for the SI 5 Administration Console.  Both the User Name 

and Password are case-sensitive. 
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18)   Confirm your install decisions and click [Finish] 

 

19)   Microsoft SQL 2005 Express will install, follow onscreen prompts. 
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20)   Once the install has completed you see the following message letting you know that you must 

make changes to the Products share folder that was created.  Click [OK] and the 

C:\DToolsData folder will open so that you can make the changes, see Folder Settings pg 33: 
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21)   Click [Finish] when prompted: 

 

22)   The login form for the SI 5 Administration Console will open. 

 

Folder Settings 
To ensure that all users have access to the Products folder you will need to make “Sharing and 

Security” setting changes to the folder.  To do this: 

1) Right-click on the folder and select “Sharing and Security…” 



SI 5 Administration  34

 

2) This step varies depending on whether your network is on a Workgroup or on a Domain.  In 

either case, DO NOT change the “Share name” of the folder.  The Share name must be named 

DToolsV5ProductShare 

Workgroup – Check the “Allow network users to change my files” checkbox 

 

Domain – On the Sharing tab you will need to click the [Permissions] button 
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You can either grant “Full Control” to the Everyone Group or you can add individual user names 

and grant them “Full Control”: 
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Click the Security tab and allow “Full Control” for the Everyone Group (you will likely have to add 

this group) your can add individual user names and grant them “Full Control” 
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Firewall Settings 
If you are using a firewall, you will need to grant access to *three programs: 

C:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\Binn\sqlservr.exe 

C:\Program Files\Microsoft SQL Server\90\Shared\sqlbrowser.exe 

C:\Program Files\D-Tools\SI 5\Server\DTools.Services.exe 

*XP paths shown.  These files may be in different locations depending on the configuration of your machine 

To do this for the Windows Firewall: 

1) Open Windows Firewall (Start->Control Panel->Windows Firewall) 

2) Click the Exceptions tab and then the [Add Program…] button to browse to and add the 

programs listed above: 
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Registration and Administration 
You should Register and Setup Groups and Users prior to installing Client 

1) Launch the SI 5 Server Administration console and login using the User Name and Password 

you set during installation: 

 

2) The interface will open to the Start Page. Click the [Register SI5.5 now!] button: 
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3) The Register form will open.  Type in your CD-Key and click [Register]. 
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4) Click [Finish]. 
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Setup Users and Groups 
The SI 5 Administration Console is where you will configure your Groups and Users.  Groups are 

where you will set permissions for Users. 

Users 
Users are managed with the User’s dropdown on the Start page.  You can add as many users as 

you desire.  The number of users  

 

Add New User 

1. Select “Add New User” and the Add/Edit User form opens  

2. Fill in the form.  The User Name and Password you create here is what you will use to login 

to the SI5.5 Client.  Don’t be concerned about Group assignment at this point.  You will 

assign the Users to appropriate Groups in the “Manage Groups” section later in this chapter.  

Role is for your reference only.   
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3. Click [Save] 

Note: You can now go install the SI5.5 Client or you can continue on with this section to establish 
your Groups and assign your users to an appropriate Group. 

Manage Users 

1) Click the dropdown next to Users and select Manager Users. 

2) The following form will appear: 
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3) Use the [Edit] and [Remove] buttons to manage existing Users or use [New] to create a new 

User. When you click [New], the Add/Edit User form opens: 

 

4) Fill in all fields and then click [Save].  Role is for your reference only.  It is not used elsewhere 

in SI 5.  Don’t be concerned about Group assignment at this time.  You will create Groups and 

assign users to those groups in the next step. 

Log off User 

This function should only be used when something goes wrong and you can’t log a user off via the 

SI 5 Client application.  Example: a user marks themselves as “LANSync offline” on their laptop so 

they can access SI 5 while away from their network and the laptop gets stolen or breaks.  In this 

scenario you could login to the SI 5 Administration Console and use the “Log Off User” option. 

 

Select the User and click the [Log Off User] button.  You will be asked to confirm: 
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Groups 
There are two default Groups in SI 5: Administrators and Everyone.  You can modify these and you 

can create your own Groups.  Typical Groups could include Sales, Engineering, Accounting, and 

Installation.   

Manage Groups 

To manage your Groups, click Manage Groups on the Start Page. 
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The following screen displays: 
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SI 5 comes pre-set with two Groups: Administrators and Everyone.  To modify the 

permissions for any Group, select the Group from the “View” dropdown and select 

“Permissions” from the Edit dropdown.  Use the [>>] and [<<] buttons to modify 

the existing permissions.  To assign Users to a Group, select the Group from the 

“View” dropdown and select “Users” from the Edit dropdown.  Use the [>>] and 

[<<] buttons to add/remove Users.  Click [Save] to save changes to a Group, 

[Remove] to delete a Group. 

 

To create a new Group, click [New].  You will be prompted to enter a Group Name: 
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Click [Next>] and you will be prompted to add Users to the Group: 

 

Add Users with the [>>] and [<<] buttons and then click [Next>].  You will then be prompted to 

add Group Permissions: 
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Care should be taken when assigning permissions.  Most permissions Grant Rights.   

However, a few cost and accounting permissions Restrict Rights.   

 

Permission Behavior 

Projects Page Grants access to the Projects tab of the Navigator 

Create Project Grants access to create a Project 

Edit All Projects Grants access to edit ANY Project 

Edit Own Projects Grants access to only those Projects created by the user 

Read All Projects Grants access to read/view Projects 

Read Own Projects Grants access to read/view only those Projects created by the 

user 

Delete Project Grants right to delete Projects 

Project Administration Page Grants access to Project Set-up Page in Navigator 

Data Page Grants access to MMPD 

Add/Edit Data Allows user to add and edit data to the database.  This could 

occur via MMPD or during project creation 

Delete Data Allows user to delete data from the Database 

LANSync Data Sync Allows modifications to the local database to update the 

shared master database 

LANSync Administrator Allows user access to the LANSync administration page.  The 

user will still need to know the administrator password. 

Edit Client Allows user to edit clients in the client table 

Delete Client Allows user to delete a client from the client table 

Data Administration Page Allows user to Compact master database, Backup master 

database or Restore master database.  

Business Manager Admin Page Allows user to administer Business Manager 
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Permission Behavior 

Business Manager Page Allows user access to Business Manager functionality 

Create Custom Reports Allows user to generate and install custom reports 

Run Excel Reports Allows user to run Excel reports. 

Add/Edit Service Orders Allows user to create or edit Service Orders 

Add/Edit Tasks Allows user to create or edit Tasks 

Assign Resources Allows user to create and assign resources 

Manage Schedule Unrestricted scheduling capabilities. Allows user to modify 

project working hours and move tasks in the resource 

calendar, as well as perform all tasks listed in Add/Edit Task, 

Add/Edit Service Order, and Assign Resources above 

Allow QuickLinks Allows user access to QuickLinks (optional, additional license) 

Restrict Cost Factors Restricts user from modifying global cost and price factors  

(see Navigator > Setup > Price in the SI 5 User Guide) 

Restrict Price Restricts user from modifying the price of a Product in the 

database 

Restrict Cost Restricts user from modifying the cost of a Product in the 

database 

Restrict Accounting Information Restricts user from modifying Tax Codes and Rates 

Once you’ve added the Group Permissions, click [Save]: 
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Manage 
The Manage tab provides some additional tools for Server data and Administration User 

management.   

 

Manage ->Database 

Clicking Manage -> Database will provide the following interface for backing up and restoring your 

Server data: 
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You should make a habit of creating daily or weekly backups of your Server data.  Be sure to 

backup this data to a different physical device.  If you are using a dedicated server, it may include 

software that will automatically backup SQL data.  This Backup and Restore function primarily for 

use if you want change the machine where the SI 5 Server is installed. 

When you click [Backup Server], you will be prompted to verify that you have checked in all 

projects and that all user are logged out of SI 5: 
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Once you confirm, you will need to Browse to a folder where you want to save your SI5.5 Server 

Backup Archive file to.  You will not need to change the path of the “Server Project Folder” unless 

you changed the defaults during install.  Click [Backup Server] when ready: 

 

Use the [Restore Server] button to restore a backup of your data.  Once again, you will be 

prompted to confirm that all projects are checked in and that all users are logged out of SI 5: 
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Once you confirm, you will then browse to where your backup file stored.  The path for where your 

SQL data is stored will be filled in for you.  Her you will make a choice between deleting or 

overwriting the existing files, deleting is recommended.  When ready click [Restore Server]: 
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Manage -> Administration Users 

This is where you can Add, Delete and Edit users that can have access to the SI 5 Administration 

Console.  These logins are completely separate from the User logins that you create for your staff.   

 

Manage->Validation Logs 

This is where logs will be recorded for any issues that you may encounter when logging into SI 5 

from a Client machine.  Our Tech Support department may use these in determining the cause of 

any issues encountered. 
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Installing the SI5.5 Client 
You should Register and setup Groups and Users prior to installing Client.  If you plan to 

use Visio, AutoCAD, or QuickBooks you must install those applications prior to installing 

the SI 5 Client 

1) Insert disc into CD or DVD drive.   

2) If the installation process does not automatically begin, browse to the CD drive and Double-

click the Install.hta file.  The D-Tools System Integrator 5.5 install from will open.  Choose 

Install System Integrator 5.5 Client. 
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3) The installer will determine if all prerequisites are installed.  Click [Next >]. 

 

4) Click [Next >] to install any missing prerequisites.  Follow the onscreen instructions for the 

third-party installs. 
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5) Click [Next >] to proceed. 

 

6) Read the Read Me file and then click [Next >] 
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7) Read and Accept the End-User License Agreement and then click [Next >] 

 

8) Click [Next >] on the Configure Shortcuts step: 
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9) We recommend doing a Complete install.  If you have QuickLinks you must do a Complete 

install so that functionality is added. 
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10) Confirm you decision to install by clicking [Install] 

 

11)   When the install is completed, click [Finish] 



 SI5 User and Administration Guide 63

 

12)   When you launch the SI 5 Client, you will be prompted to login.  This form will retain the 

values the next time you login.  Use the Username and Password that you were assigned or 

that you perhaps created yourself by following the instructions on pg. 42 of this guide.  The 

Server field should be the Computer Name of the machine where your SI5.5 Server is installed.  

The default port is 9000 unless you changed it during your installation of the SI5.5 Server.  If 

you do not know the Server or the Port, ask whoever installed the SI 5 Server on your network. 

 

13)  Run the Application Setup Wizard. 
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14)   Click “Sync product data” to establish your Server database: 
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Configuring QuickLinks 
If you installed using the “Complete” option, QuickLinks was installed.  QuickLinks is our interface 

to QuickBooks and is an additional, optional license.  QuickBooks must be installed on the machine 

where you intend to use QuickLinks. The following steps show how to configure QuickLinks for use 

on Client installs. 

You may see QuickLinks referred to as LinkTools or as LinkTools-QuickBooks in some 

of our documents and videos.  They are the same thing. 

1) Verify that you have a QuickLinks license for your company: “QuickBooks Enabled” will display 

on the Start Page of the SI 5 Administration Console 

 

2) Verify that your User is assigned to a Group that has the “Allow QuickLinks” permission: 
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3) Open QuickBooks and login as “Admin”.  This is necessary to make the initial connection 

between SI 5 and QuickBooks.  You do not need to be logged in as “Admin” to use QuickLinks 

in the future 

4) Open SI 5 and login. 

5) Select Tools->QuickLinks 
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6) You will be prompted to select your region: 

 

7) The D-Tools Quicklinks form will open. Click the [Options…] button: 
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8) The following form opens. Use the [Browse…] button to navigate to your QuickBooks company 

file and select your defaults.  When finished, click [OK].  For details on the “Item Input Mask”, 

see the Pre-Implementation Guide chapter of the SI 5 User’s guide. 

 

9) Click the [Item List] button: 

 

10) If the QuickBooks window does not gain focus automatically, click it on your Task Bar.  The 

following window will be open.  Click the “Yes, always; allow access even if QuickBooks is not 

running” radio button and click the “Allow this application to access…” checkbox. 
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You may have the option to select a “Login as” user on this form where the red 

shape is.  If you have this field, choose “Admin” from the dropdown. 

11) Click [Continue…].  You will be prompted to allow access: 
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12) Click [Yes] and then click [Done] when prompted: 

 

QuickLinks is now configured and ready to use.  See the LinkTools section of the SI 5 User’s Guide 

for details on using QuickLinks. 

 


